Tutor Module for Key Skills IT Level 2 Test

Skill Area 3 – Enter, develop and derive information

3.1 Enter and bring together information using formats that help development:
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13.1 Enter and bring together information using formats that help development


1Questions may, for example, require candidates to:


1Application software


1Ways of inputting information


1What application do you use for what task?


2Consistency - inputting data


3Font size and formats


4Paragraph styles


5Types of Headings


5What are Styles?
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8Returns


8Show/Hide
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11Control text wrapping style on image


11Tables in Word


13Tables toolbar
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16Techniques for entering information:


17Drawing Toolbar


19Practice questions





Skill Area 3 – Enter, develop and derive information

3.1 Enter and bring together information using formats that help development 

Candidates should know about different types of information that can be entered and stored in a computer and the techniques that can be used to bring together different types of information. They should know how to adjust the size and position of images and control the text wrapping style. They should also understand the importance of using appropriate and consistent formats to facilitate further development.

Questions may, for example, require candidates to:
a. identify ways of entering information (including keyboard, microphone, scanner, digital camera);
b. identify reasons for consistent use of spaces, tabs and returns;
c. identify when and why tables might best be used;
d. identify techniques for entering and bringing together information (including insert or copy and paste of text, tables, images, lines and boxes);
e. identify techniques used when inserting images (including position, text wrap and the use of behind/in front);
f. identify text boxes or frames as a useful technique to insert, combine and position text in a document.
Application software

This section will give an idea of what different software packages are used for, so that the candidate can choose the most appropriate for entering their data.
Ways of inputting information

· The keyboard is the main in-put device followed by disk, CD and scanner.  

· There are many people who use a microphone to ‘dictate’ to their computer.

· The digital camera is used for work and play for inputting photos.

What application do you use for what task?

Word processing

	Examples of tasks it’s used for
	Other tasks it can deal with

	Text and Word Processing

Letters

Reports

Faxes

Memos

Handouts

Lists

Mail merge documents
	Tables 

Sorting data

Spreadsheets 

Graphs

Column headings (change orientation)




Spreadsheet processing

	Examples of tasks it’s used for
	Other tasks it can deal with

	Manipulation of numbers and text

Lists of figures

Costings

Sorting figures

Creating formula

Invoices

Statements

Database
	Mail merge

Filtering

Graphs




Data processing 

	Examples of tasks it’s used for
	Other tasks it can deal with

	Tables

Manipulating sets of data and figures

Lists of names and addresses

Customer details

Price lists

Invoices

Lists of figures

Lists of data
	Forms – to make data entry easier

Queries – to interrogate information

Reports – to give a professional look to documents

Letters – which look like Word processed documents

Financial calculations (using formula)


Graphical representation 

	Examples of tasks it’s used for
	Other tasks it can deal with

	Displaying text and numbers

Easy-to-read format to aid recognition of the differences between sets of data.

Graphs and charts to show variations between profit and loss

Temperatures

Success rates

Number of items sold
	Part of a word processed document – it can be copied and pasted as though it is a piece of clipart or a picture


Consistency - inputting data

Layout in inputting is very important to give balance and clarity to the display of information.  If the work doesn’t include headings or a consistency of layout, it will be more difficult for the reader to appreciate the information and find what they are looking for.  Although we are using Word as our example, Excel and Access are very similar.

Below are a few guidelines on how to lay out documents.

Font size and formats

[image: image1.png]il =5 x]
File Edit View Insert Fomat Tools Table Window Help

DEH2 ERY {BRI v % 0 BB g oo - @)

ol S
J DOt F=EEY .

Format Pictur [21x]

et ]| e | oot | e | | web
"

Colr worl o] I

ine

Calor: Mo Line B

Arrows

ok Cancel

Page 1 Sec 1 1 [Ac2sm Ini ol Englsh (U5 | G2

& A5 || E)3% Floppy (&) |[picture g- Mi.. BDocument2 - .. | [ e OBEEL 1757




Format menu, Fonts, enables you to select the font and size you want.  You can see what the fonts look like before you select them. You can also click into the box and type the font size you want.  Press return and it is set.
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You should be careful which font style you choose. If you choose a font that is only in capital letters, THIS IS VERY DIFFICULT TO READ IF THERE IS A LOT OF READING TO DO. You should also avoid using fonts that are too fancy, ie, Old English is also very difficult to read.

Font sizes should generally be between 11 and 14 for normal reading.  The general rule is that it should be bigger than size 10 and no larger than size 14 for the body of the work.  Headings are larger.  If you are trying to show information on a chart and are limited to how much information is shown on one page, you can reduce the font size.

This is font size 11

This is font size 12

This is font size 13

This is font size 14

This is font size72

For display purposes (posters and handouts), the rules don’t really exist.  Balance and style should match the document.

Short-cut to changing font size

You can use Control and [  or  ] (square brackets to the left of the Return key on your keyboard) to increase and decrease font sizes one size at a time.
Tips on producing posters and adverts

Posters
Produce your poster, pin it to a wall, stand back and see if the main points can be seen from a distance.  If not, make appropriate changes.


Check that there is a date, venue, contact name, address, telephone number, website or email address if the poster is giving information or advertising an event.  


Is the poster bright, eye-catching and attractive?

Adverts
There are a few words which catch the eye … one of them is ‘FREE’.  This should be prominently placed in large letters to get the viewer’s attention.  Again, check that there is contact information for interested parties to respond to.

Paragraph styles

This is an example of a blocked or left-justified paragraph.  It has a ragged right-hand margin.  Every line starts flush with the left-hand margin, but the lines don’t end flush with the right-hand margin.  It is different to a fully-justified paragraph. Normally you would use the left justify paragraph styles on the majority of all documents.

This is an example of an indented paragraph.  The first line of each paragraph is indented 5 spaces.  These 5 spaces should be achieved by pressing the Tab key on your keyboard so that the indentation is consistent.

This is an example of a fully-blocked or fully-justified paragraph.  It is different to a blocked paragraph, which only has a justified left-hand margin and a ragged right-hand margin. Every line starts flush with the left-hand margin and ends flush with the right. Normally, you would use the left justify or full justification paragraph styles on the majority of documents.

This is an example of a centered paragraph, where every line is centered 

between the margins of the work. The main use of centered 

paragraphing is for adverts, leaflets, flyers and display work.

Selecting paragraph style

The Format menu shows the four options:
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     Left 
  Center
Right

Full Justification

Paragraphing hot keys

The macros on the Formatting Toolbar will help with justifying and centering your paragraphs.  You can also use hotkeys:

Ctrl and R = right justify

Ctrl and L = left justify

Ctrl and E = center justify

Ctrl and J = fully justify both margins

Types of Headings

MAIN HEADING

A main heading is made to stand out more than other text, either by using bold, underline, capital letters or a larger size font.  Its purpose is to introduce the subject that follows.
Sub-heading

Most information laid out in the style of a report, a newsletter, etc, has a main heading, followed by sub-headings to introduce the different topics/elements of the information.  It helps the reader and allows them to find information relevant to them quickly.

Sub-headings come in different styles:

Paragraph Heading:  This is a paragraph heading and is part of the paragraph it belongs to.  There should be a colon or space after the paragraph heading and it should be made to stand out in some way – perhaps by use of bold, underline or capital letters.
Side Heading
This is an example of a side heading.  It sits to the left of the associated paragraph.

Shoulder Heading

This sits on the shoulder of the paragraph it relates to.  That’s why it’s called a ‘shoulder’ heading.  It may have a blank line space between it and the paragraph below.

What are Styles?
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Styles can be found on the Formatting toolbar. They are there to help with consistency and can be used with headings.
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Click on a heading and select an appropriate Style or Ctrl + Alt + 1 for Heading 1, Ctrl + Alt + 2 for Heading 2, etc.  These go in levels.

Styles can then be used to create automatic Indexes and Tables of Contents (Insert, Index and Tables – select appropriate item).

The Index at the beginning of each section in this Tutor’s Toolkit has been created this way.  It acts as a hyperlink to each section.  Press Control and click one of the items in the Index, and you will be taken there.

Spaces

	When used: 


	Number of spaces

	Between words:
	1

	After full stops and commas
	1

	When using a forward slash (/) between words
	No space before or after

	When using a colon/semi-colon (: ;)
	No space before, but 1 after

	When using a dash ( - ) (splits sentences, ie, … it was saved – only to be …)
	1 before and 1 after

	When using a hyphen (-) (joins words, ie, part-time)
	No space before or after

	When using ellipses ( …  3 dots only)
	1 before and 1 after


You can adjust the spacing between characters by selecting Format menu, Font, Character Spacing.

Non-breaking space
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To keep words together, i.e. proper names, if they naturally break at the end of a sentence, create a non-breaking space: Ctrl + Shift + Spacebar. In the example below, when Show/Hide (Details are on page 8) has been clicked, the non-breaking space between Jules MaCready is shown as a circle above the line.  A normal space is shown as a small dot – as you can see between all the other words:

Line spacing
	When used
	Number of line spaces

	Headings
	Generally 1 before and 1 after heading, unless you are using double-line spacing.  This will then change to 2 before and 2 after.

	Between paragraphs
	1 clear line between all paragraphs regardless of document type

	On letters, between Yours faithfully, etc. and name of signatory
	5 clear line spaces (for signature)


You can adjust the spacing between lines by selecting Format menu, Paragraph, Indents and Spacing. 

Quick tip on changing line spacing in paragraphs:  

The quickest ways to change line spacing :

Ctrl 1 = Single-line spacing – this is where there are no extra line spaces between the lines of type.

Ctrl 2 = Double-line spacing – this is where there is a full blank line space between the lines of type. This example shows how much space there will be if this option is selected.

Ctrl 5 = One-and-a-half-line spacing – this is where there is half a line space between the lines of type. This example shows how much space there will be if this option is selected.
Tabs

Tabs are generally set on default at every 5 spaces.

You can use tabs to create columns of information and to keep them in line. For example:
Gill Minett

2 hours

Sarah Bushfield
3 hours

Margaret Blewett
3 hours

Margaret Laverty
4 hours

However, you can also use tables to achieve the same results (see section on Tables, on page 11).
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Most word processing programs have pre-set tabs (defaults) every 5 spaces.  You can set your own by selecting:

Format menu, Tabs
You can also manually set them by using the ruler at the top of your page.  If this isn’t showing, select:

View, Ruler
And click to add a 
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Types of tabs and indents

There are different tabs for different jobs.  Select the type of tab you want from the Ruler line.  Now click where you want your tabs set (on the grey section at the base of the ruler line).  You will see a black L to show where your tabs are.
These can be used to move in one line or blocks of text.  This is usually done so that the paragraph or sentence in question stands out from the rest of the work.
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Left indent is for indenting a paragraph from the left margin. The rest of the paragraph is also indented and blocked against the left indent.

Right indent is for indenting a paragraph from the right margin. The rest of the paragraph is also indented and blocked against the right indent.

First line indent is for indenting the first line of a paragraph from the left margin.  The rest of the paragraph blocks against the left-hand margin.

Hanging indent is for a hanging paragraph, ie, the first line touches the left margin with all following lines indented three places.

Returns

To make a clear line space between paragraphs you must press return twice - once to break the line, once to give a clear line.

Force a page break

Ctrl + return = forces the page to break onto the next page.

Show/Hide

By clicking on the Show/Hide macro, you will be able to see where your spaces, returns and tabs are.
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This symbol shows where a return has been pressed.
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A tab is shown as an arrow.


A space is shown as a feint dot half way up the line of type.  (
A page break is shown by a dotted line and the word Page Break.
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Images

Insert image

Although this is mainly relevant to Word, it also applies in Excel, as well as Forms and Reports in Access. An image is easily formatted.  But first, you need to insert it into your document.

Insert, Picture, Clipart (or if a saved picture, Insert, Picture, From File)
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ClipArt: Once you have opened the ClipArt menu, select the image and click the top icon on the pull-down menu to insert ClipArt.  
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Picture: Insert, Picture, From File.  Double-click on Picture file to insert (or select Insert).
Formatting Image
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The quickest way to call up the picture formatting menu is by double-clicking on the picture itself.  You can also use Format Menu, Picture.
You can adjust:

· colours and lines

· size

· layout

· picture

Formatting colours and lines on image

This will allow you to put a line or box around the picture, infill it with colour, etc.  The following piece of ClipArt shows a ‘before and after’ picture.  The picture must have with white space behind to infill colour:

Before







After
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Control text wrapping style on image

[image: image18.wmf]To wrap text around a picture, click on the Wrap Text macro on the Picture toolbar and select the most appropriate (a little dog with lines is used to symbolize how the work will look!). The following picture shows a close-up of how the text wrapping is affected by the picture.
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You can also double-click on the picture itself and select the macros in the Layout section.
Horizontal alignment of image

You can position your picture by using the Horizontal Alignment, which is also found on the Text Wrapping menu.
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Tables in Word

· Tables can be used for tabular work including numbers.
· You can use them for lists, so that the information is clear.

· You can use them to create a database for mail merging with another document.

· You can sort them into order and even add them up.  You can also change the direction of text.

· You can erase lines and draw new lines.

· You can change the style of the lines as well.

Tables with gridlines

The table below shows that gridlines have been used to divide the information.  One heading has changed direction, and the borders lines have been reformatted using a different style.  The total for the wages column has been calculated using a formula:

	Name
	Date of Birth
	Telephone No
	Wages

	
	
	
	

	Suzanne Smith
	15.04.59
	0778945612
	£360.33

	James Jones
	18.05.63
	0894563217
	£420.00

	
	
	
	

	Total:
	
	
	£780.33


Tables without gridlines

This is the same table, but the gridlines have been removed by selecting Format menu, Borders and Shading, Borders, None. When it is printed, the lines cannot be seen and the work will look like a piece of column work.

	Name
	Date of Birth
	Telephone No
	Wages

	
	
	
	

	Suzanne Smith
	15.04.59
	0778945612
	£360.33

	James Jones
	18.05.63
	0894563217
	£420.00

	
	
	
	

	Total
	
	
	£780.33


The advantage of using tables is that it is easy to keep information where you want it.  You can also move the gridlines easily by clicking and dragging them (even when they can’t be ‘seen’). To add tables, select Table menu, Insert, Table.
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You can also use the Format menu and select the Insert Table icon:

Tables toolbar

To add the table toolbar, select View, Toolbars, Tables and Borders.

[image: image24.bmp]
This toolbar will allow you to work with tables to:
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Draw lines and erase them.
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Change the line type, weight (thickness) and colour.
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Insert table, merge and split cells.
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Align top left, distribute rows and columns evenly.
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Auto-format the table or change the direction of the fonts.
[image: image30.png]2l Documentd

osoft Word

| File Edit View Insert Fomet Tools Table Window Help

D2Ea8RY|iaad -~ QEOR=EHET we -0,

[oma o celB 2z

O-2-A-

B

g4 s

R O IR |
Right Indent]

szl

[ e

Asart]| & B PG

= Tl [z [ [ [0 [Engish Wk [ G |

|| #1Dsc...| By BEBC | EMic...| By Ten..| @1 Topt. |[@Doc... | @ OBER 1514





Sort information into ascending or descending order, or calculate (add) numbers (as in a spreadsheet). 

Mail Merge

This is a function that some word processing software offers.  It produces multiple instances of a document by substituting different text strings from a database in place of certain field markers. This is often done with envelopes, letters, spam and various other mass mailing documents.
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Mail merging with another document is easy using Microsoft Word, as long as you read the screen on the pull-down menu.  You can merge with an Excel or Access database or create your own database in Word.  

Select Tools menu then Mail Merge:

Read the top of the menu for instructions, i.e. Use this checklist to set up, etc.  Select Create, Form Letters (or whichever type of document you want – Form Letters is fine for any word processed document).
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Now for the Data Source. If you already have a database you want to use, select Get Data.  If you are going to create your own database on Word, select Create.
Create a mail merge database in Word

Click the Get Data macro and select Create Data Source.

Remove all the existing field names and add your own. You MUST NOT put spaces between the names or you won’t be able to add them:
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Once you’ve done this, click OK, and the data form will appear.  Fill in details 

Fill in the data form with your details:
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Click OK when this is complete. There will now be a new toolbar on your screen, which isn’t always immediately noticeable.  It allows you to insert the merged fields into your document:

Click on the arrow next to the words Insert Merge Field:
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Insert the field markers:
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To merge the data with the database, you need to recall the Mail Merge Helper.  To do this, select the macro from the Mail Merge toolbar:
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Select Merge and Merge again. Your data will now be merged with your word processed document.
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Merging with Excel or Access databases

To merge with Excel or Access databases, when you are asked to Get Data, ask for Open Data Source.

From there, select the Folder where the database is stored, then select the document type (or you won’t be able to see it, as you are in Word and only Word documents can be seen).  Once the correct software has been selected, you will be able to see your document.
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Once selected, select Merge and Merge again as before.

Techniques for entering information:

Copy and paste of text
Shortcut keys for copy and pasting: 

Ctrl + C = copy

Ctrl + V = paste

You can select the Edit menu and copy and paste from there, or right-click your mouse and select Copy, Cut or Paste. 

Adding lines and boxes
There are several ways to add lines or boxes:
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On the Format Toolbar the following macro will allow you to add lines.  Click on the down arrow to the right and select from the following menu:

[image: image46.wmf]
You can draw lines using the Tables and Borders toolbar (see previous section).
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You can use the Drawing toolbar to add other types of lines (View, Toolbars, Drawing).  You generally find this toolbar at the bottom of your screen.

Drawing Toolbar

Group objects
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This tool is in the Draw macro.  It is only ‘active’ when an object is selected, i.e. select one object by clicking on it. Now hold Shift to select a second object which you want to be part of the same object. Click on Group and the two objects become one.  You can de-select by using the same method.

You often want this option when you are using an arrow to point to something on a screenshot of a toolbar or picture, to highlight information.

Rotate image

To use Rotate, insert or draw a shape/AutoShape, i.e. an arrow, a callout, etc.  Click on it - the white ‘handles’ show the arrow is active – and select Rotate. Green circles appear.  Hold onto these with your cursor, and rotate the object. You can use this for some pictures as well (but not all).


AutoShapes, line, arrow


Rectangle or oval box


Text box


Word Art


Clipart

To add a text box to a shape, draw your box or oval, then click on Text box and place over the top of the shape. Without it, you won’t be able to type in the shape.


Colour 

Fill boxes with colour.
Change line colour.
Change font colour.
Line style, dash style and arrow style


On the same toolbar, you can change the way boxes or shapes look.
Line style

Dash style

Arrow style

Shadow and 3D

These give your boxes a shadow or 3-D effect.


Practice questions

1) Identify 3 ways of inputting information.

2) Identify the following formatting from the example article:

a. How was the heading formatted?

b. How is the text wrapped around the image?

c. What paragraph formatting was used?

3) In the spreadsheet example, state the position of text in the following cells:

a. Heading – Cell 1A:1H

b. Column heading, Name, in cell A3

c. Number in cell B4

4) Identify a better way to display the following data:

Tourist currency exchange rates

Australia  2.29 dollars

Barbados  3.31 dollars

Canada  2.22 dollars

Hong Kong  13.30 dollars

United States  1.72 dollars

5) How could the heading, ‘Tourist currency exchange rates’ (above) be displayed to a better advantage?

Answers

1)
Keyboard, disk, CD, scanner, microphone, digital camera, copy and paste, etc.

2)
a)
Word Art

b) Square wrapping

c) Fully justified

3)
a)
Centred

b)
Left justify

d) Right justify

4)
By using a spreadsheet or table 

5)
By emboldening, increasing the size, underlining, etc.
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